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Supplier User Guide

Luminate Control Tower

Welcome to the Luminate Control Tower (LCT) User Guide for supplier partners. This guide is designed to 
help you navigate and effectively use the LCT system.

Purpose: The purpose of this guide is to provide supplier partners with comprehensive instructions on how 
to utilize Luminate Control Tower for seamless collaboration with Medtronic. By following this guide, you 
will learn how to:

• Access and interpret material plans  and purchase orders.

• Collaborate on purchase plans and purchase orders.

• Share and view on-hand inventory levels at both Medtronic and supplier sites.

• Utilize collaborative messaging and workflow tools for efficient communication, planning, and issue 
resolution.

Audience: This guide is intended for Medtronic's supplier partners who are involved in supply chain 
management, including those responsible for planning, ordering, inventory management, and 
communication with Medtronic.

This guide aims to ensure that you can maximize the benefits of LCT, enhancing supply chain visibility, 
improving communication, and mitigating supply risks.

User Guide Overview

1. Introduction

2. Log-in 

3. Basic Functions Overview

4. Purchase Forecast

5. Purchase Order Confirmation

6. Shipping Notification

7. Inventory

8. Documents

9. Situation Room

10. Alerts and Notifications

11. Macro Setup and Usage

Table of Contents

Note: Click on the       icon on the following pages at any time to return to the Table of Contents.
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Blue Yonder Luminate Control Tower (LCT) will be utilized for data flow between Medtronic and our 
suppliers. With a 36-month forecast, visibility to material plans  and purchase orders will be a part of our 
integrated materials planning process.

Introduction

Optimize inventory

Share inventory data for simpler supply risk mitigation

Increase stability

Collaborate on supply commits, max capacity, variance

Reduce waste

Use real-time communication for greater planning precision

Luminate Control Tower (LCT) facilitates seamless two-way 

collaboration between Medtronic and our suppliers. It 

allows the sharing of material plans  and purchase orders 

generated in the Enterprise Supply Planning (ESP) system 

directly with suppliers, forming an integral part of our 

materials planning collaboration process.

Both Medtronic personnel and our critical supplier partners 

can use LCT to view planning data and collaborate on 

supply commitments, maximum capacity, and variances. 

Additionally, LCT provides a dedicated platform for sharing 

inventory data and tools designed to simplify supply risk 

mitigation.

General Functionality

• Purchase Plan Collaboration: Facilitates 
the receipt and agreement of the 
Purchase Plan with Medtronic partners.

• Purchase Order Collaboration: Enables 
collaboration on open purchase orders, 
providing interactive status updates and 
enhanced visibility.

• On-hand Inventory at Medtronic and 
Supplier Sites: Allows sharing of on-hand 
inventory levels at both Medtronic and 
supplier sites.

• Collaborative Messaging and Workflow: 
Supports communication, planning, and 
issue resolution.

What does this mean for suppliers?
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Log In

1. To access click on Luminate Control Tower the click on 
Sign In

2. Sign into medt-prod and click continue

3. Select the Medtronic Supplier sign in option
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Log In (continued)

4. If you have existing account – enter your email – then 
password

5. If you have do not have an existing account – select sign 
up

3. Once login is complete – basic portal access will be 
enabled. 

4. The next step is to advise your Medtronic counterpart 
that you have an active account.
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Basic Functions

1. To access the slide-out menu options, click on the three lines 
located at the top left of the screen.

2. Each section can be expanded by clicking on the arrows to 
the right.

3. Click on any of the sub-sections to access the data.

The two icons at the top right of the LCT main pages have the 
following functions:

1. This icon opens the Situation Room menu.

2. This icon allows you to view notifications, alerts, and 
configure alerts.

Navigation Menus
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Basic Functions

1. LCT enables users to search for products and filter data 
based on specific criteria.

2. These functions are accessible in every section of LCT.

3. Global Filters will be applied across all pages.

4. Click on the "+" sign next to Advanced Filters to open more 
filtering options. 

Access Search and Filter Functions 
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Forecast Commits

This functionality allows Medtronic’s buyers to share new or revised purchase forecasts, and suppliers can 
view and make commitments based on these forecasts. It's important to update this regularly as it will be a 
crucial component of our collaboration together.

1. Open the navigation menu and click on Forecast Commits

This functionality allows LCT to identify exceptions based on the data shared. These can filter the data, and 
multiple can be selected at a time to display the relevant lines.

1. Forecast-Commit Mismatch: A mismatch between forecast and commits entered by supplier

2. New Forecast: New forecast that has published

3. Revised Forecast: Forecast has been revised

4. Forecast-Commit Interlock: Forecast matches commits entered by supplier

5. No Exceptions: Forecast has not been published

Details and Usage

Exceptions
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Forecast Commits

As part of the forecast collaboration, we will request information on two key variables: 

• Commits 

• Maximum Capacity

The Forecast Commits Details Page allows you to publish a commit against the forecast for the products 
you supply to Medtronic. When the forecast is published, LCT automatically fills the forecast values as 
commits. As a supplier, you can review your own commits and modify them for specific dates as needed. 
You also have the option to download new or revised forecasts to Excel for updates. Once you have made 
the necessary changes, you can upload the commits back to LCT.

Additionally, the Forecast Commits Details Page enables you to publish your max capacity for specific 
periods. This is a crucial part of the collaboration process, allowing you and your Medtronic representative 
to align on expected demand volumes with clear expectations based on shared data. You can also update 
the max capacity fields for multiple periods by mass-uploading the values.

1. Click on the exceptions you want to see or use the search or filter options to find a specific item.

2. Click on the Item number 

Commits and max capacity

Access Forecast Commits Details Page

September 2024



Supplier User Guide

Luminate Control Tower

Forecast Commits

The following information related to the item you selected will be displayed:

Forecast: This is the purchase forecast required to fulfill the demand.

Commits: Quantity that will be supplied to fulfill the demand

Upside Capacity: Difference between max capacity and Commits 

Max Capacity: Supplier’s maximum production capacity values 

Unconstrained Forecast: Total demand forecast 

Details Page
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1. Click on the Actions button to display the Edit and Autofill options

2. Select "Edit" to modify an individual value for a specific period. Once finished, click the Commit 
button. This will update your Forecast Commits for the material and provide an alert to Medtronic 
Planning personnel.

3. Select "Autofill" to fill the committed quantities with the forecasted values for all periods. Once 
finished, click the Commit button. This will update your Forecast Commits for the material and 
provide an alert to Medtronic Planning personnel.

Forecast Commits

Forecast Commits for materials can be updated individually or by mass upload.

Update an Individual Material Forecast
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Forecast Commits

Commits and max capacity (Mass Upload)

Entering updates to multiple materials and time periods at once is also possible with LCT.

1. Enter the Forecast Commits screen. Apply advanced filters or filter by exceptions if desired
2. To export all or the desired range, click on the      button, top right of the screen. 

3. A pop-up will appear, allowing you to select measures and a timeframe.
4. To update commits and the max capacity, we recommend selecting "Forecast" in addition to 

Commits and max capacity.
5. Click export

6. To retrieve your export, go to the Documents page.
7. The forecast export will populate here for retrieval, click download.
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Forecast Commits

Commits and max capacity (Mass Upload) (continued)

8. It will download and open as an excel spreadsheet for editing.
9. When you open the Excel Document, delete the Summary Tab          as well as any other tabs 

that may be part of the file. Only the “Forecast” tab should be uploaded.  

10. The two columns to be adjusted before upload are 
“Measure” and “Quantity”.

11. On the Measure column replace “Forecast” with 
“Commits” to align your commits directly to our 
forecast plan.

12. Update the "Quantity" for each "Commits" based on 
the amount you can commit to delivering on the 
specified date. For instance, in the screenshot 
provided, if you can deliver 20,000 units on 
10/08/2024, you would update the quantity in the 
third row to 20,000 units.

13. To mass update “max capacity”, copy and paste all 
“Commits” rows directly below on the same sheet and 
change the Measure from “Commits” to “max 
capacity” and update Quantity.

14. Save the file and return to the LCT Forecast Commits Page.
15. Click the      icon to mass-upload your Commits and max capacity.
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Forecast Commits

Commits and max capacity (Mass Upload) (continued)

16. Select the file you want to upload from your desktop 
and click “Confirm Upload”.

17. To confirm whether your upload was successful, 
please return to the Documents Page and ensure that 
the uploaded document was completed successfully. 
You can also review the materials individually on the 
Forecast Commits page to ensure that the values you 
updated are in the system.. 

For Excel Macro training that can simplify this process, please click here.

Note: Installation and usage of macros require IT permission or compliance with company policy.

LCT Macro
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Inbound Orders

LCT facilitates collaboration between Medtronic and suppliers on purchase orders. As a supplier, you can 
confirm purchase orders if you can commit to delivering them on time and in full (OTIF) for both the 
specified date and quantity.

1. Open the navigation menu and click on Orders

1. Past Due: purchase orders that are still open beyond 
the expected delivery date

2. Unconfirmed: purchase orders requiring on-time, in-full 
confirmation

3. On Time: purchase orders labeled as projected on-time, 
in-full

Details and Usage

Exceptions Filters

1. New: purchase orders issued in the last three days

2. Open: All purchase orders that are still open and older 
than three days

3. Confirm OTIF: purchase orders where at least one line 
has been confirmed on-time, in full by Supplier

4. Shipped: purchase orders with lines that have been 
shipped by Supplier

5. Received: purchase orders with items marked as 
shipped by the supplier and closed in Medtronic's 
system will appear as received for 7 days.

6. Closed: purchase orders with no open lines

States Filters
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1. Click on the order number to display the purchase order details.
2. To confirm a purchase order on time, in full (OTIF), select the PO by checking the box and click 

"Confirm OTIF.“
• To confirm more than one purchase order at a time, select multiple lines.

3. Click on the order number to view the purchase order details.
4. To see PO line details, click the dropdown arrow on the right.

5. PO line details displayed. 

Inbound Orders

Update On Time In Full
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6. To confirm a PO line, select the PO line by checking the box and then click the confirm OTIF button.
7. To confirm more than one purchase order line at a time, select multiple lines.

Inbound Orders

Update On Time In Full
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To confirm individual PO lines, across a single or multiple PO’s:
1. Search for the Order Numbers you wish to update on the inbound Orders Screen.
2. With your desired orders displayed, click the download button.

3. Navigate to the documents page to export your 
download by clicking Download.

4. The file will open as an excel spreadsheet. Review the 
file to see: 
• Order No (Column A)
• Item (Column J)
• Line No (Column R)
• Operation Name (Column AN)

5. Change Operation Name (Column AN) entries to 
“ConfirmOrderOTIF” for each PO line you wish to 
confirm.

6. After updating all relevant lines, save the file and return to the Inbound Orders Page in LCT. Click 
the Upload button

Inbound Orders

Mass-Upload Update On Time In Full

Update OTIF Status for each single PO Line
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7. Select Standard PO and click Choose File. Select your upload file and click Confirm Upload. 

8. Navigate to the documents page to verify your upload was successful.

9. To verify if an individual order line updated, return to the Orders screen and click an updated 
order. 

10. Click on the Expanded View button on the right to view each line state.
11. Header state will not change unless all lines are confirmed OTIF. 

Inbound Orders

Update OTIF Status for each single PO Line (continued)
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Shipping Notifications

Advanced Shipping Notifications (ASN) can be viewed on the ASN page.

1. Open the navigation menu and click on ASN

2. To view an ASN, select it by clicking on the dropdown arrow. 

3. Shipping notification details will display

Details and Usage

September 2024



Supplier User Guide

Luminate Control Tower

1. You can generate ASNs for confirmed purchase orders directly from the Inbound Orders page. 
2. Check the box next to the purchase order or PO lines for which you want to create the ASN. 
3. Click on the “Create ASN”.

4. Review the purchase order (PO) details, select the line by checking the box on the left, and then 
click "next.". 

5. Review Shipment Details:
• Enter the following details:

o Carrier 
o Ship Mode (Ocean, Air, Rail, Ground)
o Supplier ASN Number 
o Booking number

• Click on “Create ASN” after entering the relevant information.

• View the ASN on the ASN's page.  

Shipping Notifications

Create an ASN (single PO line)
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1. You can generate ASNs for confirmed purchase orders directly from the Inbound Orders page. 
2. Check the box next to the purchase order or PO lines for which you want to create the ASN. 
3. Click on the “Create ASN”.

4. Review the purchase order (PO) details, select the lines by checking the box on the left, and then 
click "next.". 

Shipping Notifications

Create an ASN (multiple PO lines)
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5. Review Shipment Details:
• Enter the following details:

o Carrier 
o Ship Mode (Ocean, Air, Rail, Ground)
o Supplier ASN Number 
o Booking number

• Click on “Create ASN” after entering the relevant information.

• View the ASN on the ASN's page.  

Shipping Notifications

Create an ASN (multiple PO lines) (continued)

1. To view created ASNs, go to the ASN Page
2. To cancel an open ASN, check the box next to the ASN and click “Cancel ASN” in the top right of the 

interface.

3. It will ask you to confirm, please click yes to accept.

Cancel an ASN
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Inventory

LCT enables collaboration between Medtronic and suppliers, allowing them to share inventory levels for 
various products.

1. Open the navigation menu and click on Inventory

2. To view an Inventory information, click search for the product you want to view the inventory for. 
The inventory page will show the available stock for each location.

3. Shipping notification details will display

Details and Usage
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Inventory

1. From the inventory page, apply any searches or filters as desired before downloading the data.
2. Click the      icon in the top right to download the inventory data.

3. Set your timeframe and click “Export”.

4. To retrieve your export, go to the Documents page.
5. The inventory export will populate here for retrieval, click download:

6. The document will download and open as an excel spreadsheet for editing.
7. Delete Summary Tab                       before uploading. 

LCT also facilitates collaboration on On-Hand Inventory information for both Medtronic and suppliers. The 
simplest option for suppliers is a mass upload, similar to the Forecast Commits process. Regularly 
updating your inventory totals is essential for effective collaboration, as this information is used to adjust 
our internal plans.

Mass Upload
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Inventory

8. Review and enter On Hand Inventory.

9. Update the current stock quantity per item.
10. Important Notes:

• Don’t modify any other fields
• “Site Owner” should have the same value as “Site” 

11. Save the file and return to the LCT Inventory page.
12. Click on the      icon to upload the file to LCT.

13. Select your upload file from your desktop and click “Confirm Upload” on the following screen.

14. To review if your upload was successful, return to the Documents tab in LCT.

Mass Upload (continued)
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Documents

LCT will enable the download and upload of information.

1. Open the navigation menu and click on Documents

2. To download and upload, find the upload and 
download icons in the right corner of the 
different pages.

Details and Usage

• The "Documents" page contains a list of all uploaded and downloaded files.

• Click on All Files to see the Uploaded and Downloaded Files. 

• Select “Download” under Type to download the files. 

Document Details
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Situation Room 

A situation room is a dedicated space where key individuals from Medtronic and supplier representatives 
can collaborate, share information, and make collective decisions to address a specific situation effectively.

1. Click on the Situation Room Icon at the top right of the page. 

Details and Usage

Situation Room Overview

1. Active: The "Active" tab displays the number of active 
rooms you are part of and provides a quick overview of 
each room, including participants and the context of the 
situation being addressed.

2. Invites: You can use the Invites tab to see all the invitations 
you've received to join an existing room.

3. Resolved: In the "Resolved" tab, you can access the situation 
rooms that have been resolved. If you created the rooms, 
you also have the option to delete them.
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Situation Room 

You can create a situation room from any of the pages in LCT. 

1. Go to the corrEnterprise Supply Planningonding details page and choose a data element (Forecast, 
Purchase Order, Inventory, ASN). Then, click on the “Situation Room Icon” located in the top right 
corner of the page. (see previous slide)

Create a Situation Room 

2. Click on “Create” to create a new situation room. 

3. The details related to the data elements will be pre-populated 
on the new situation room. You can change the “Room Name” 
if needed and enter a description. 

4.  Use the rEnterprise Supply Planningective dropdown menus 
for "Issue Type" and "Add Users" to identify the issue that 
needs to be addressed and invite others to collaborate in the 
solution. 

5. Click on “Create”

September 2024



Supplier User Guide

Luminate Control Tower

Situation Room 

Join a Situation Room 

1. To join a Situation Room, click on the “Situation Room Icon” at 
the top right.

2. Then, find the "Invites" section, choose the situation room you 
want to join, and click "Join". 

3. Once you've joined the Situation Room, you'll be able to see details, chats, and files. 

a) Details: Add more users or resolve the Situation Room.

b) Chat: Enter a message and attach files to the room using the paperclip icon. 

c) Files: Review the previously attached files or add more if needed
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Situation Room 

Resolve a Situation Room 

1. To “resolve” a Situation Room that you created, select 
the specific Situation Room you want to resolve from 
the Active section.

2.  Click on “Resolve Situation” 

3. Select a “Resolution” from the dropdown menu

4. Click on “Confirm”

5. After the Situation Room has been resolved, all 
participants will receive a notification. 
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Alerts and Notifications

In LCT, you can set up alerts for specific data elements. To effectively manage your notifications, you can 
customize the criteria for when you receive alerts. Please note that you can only configure alerts for objects 
that you have permission to access.

Details and Usage

Access Alerts 

1. Click on the Alerts and Notifications icon in the top right 
corner to display the options.

2.  Click on Alerts to display all the alerts.

3. You can select specific tabs to view the alerts.
4. Click on the dropdown arrow to view details for a specific 

alert

Set Alert Preferences 

1. Click on the Alerts and Notifications icon in the top right 
corner to display the options.

2. Click on Alerts to display all the alerts.

3. Click on the “Settings” Icon. 
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Alerts and Notifications

Set Alert Preferences 

1. Choose the category for which you want to set alerts (Forecast Commits, Inventory, Standard 
purchase orders).

2. Move the toggle button to the right to enable editing.

3. Click on the dropdown arrow to the left of “Define Condition” to set up the alerts for the different 
options.

4. Select the criteria for the different alerts you would like to receive and enter the corresponding 
information.

5. Set up Advanced Filters as needed.

6. Choose where to receive the alerts. Please note that "In App" and "Email" are the only available 
options for alerts.

7. Click Save.

1

2

3

4

5

6

7
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Alerts and Notifications

Notifications

1. Click on the Alerts and Notifications icon in the top 
right corner to display the options.

2. Click on Notifications to display all the notifications.

3. Select the Sort By dropdown menu to sort the 
notifications by category.

4. Click on the All dropdown menu to filter by 
timeframe. 

Note: Notifications are generated whenever an alert is created. To minimize the number of notifications, 
ensure that you configure the alerts according to the information you want to receive.
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Create the Marco File
Create a Forecast Commit 
upload file

Create a max capacity 
upload file

This Macro runs to reformat the 
exported Forecast file from LCT. 
This is your starting point to 
create the other two sheets you 
will use for uploads. 

This Macro reformats the Macro 
File to easily enter your Forecast 
Commits. This macro will 
reformat the extracted data in 
the Macro File to allow for quick 
and easy entering of Supplier 
Forecast Commits for reupload 
back into LCT.

This Macro reformats the Macro 
File to easily enter your max 
capacity. This macro will 
reformat the extracted data in 
the Macro File to allow for quick 
and easy entering of max 
capacity Commits for reupload 
back into LCT.

LCT Macro Setup & Usage Overview

This macro is designed to streamline the process of reformatting LCT exports required for uploading data. 
Once set up, this Excel Macro requires just a few simple clicks to generate formatted templates for LCT 
uploads. 

It has three major functions to enhance efficiency:

• Reformat downloaded files for macro usage.

• Create a Forecast Commit upload file.

• Create a max capacity upload file.

Macro Objective

Macro Applications
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Installing & Enabling the Macro

Download & Install

1. Download the provided file: Personal.XLSB (Attached by email)

2. Copy and paste the file into the below path:

a) C:\Users\<YourUsername>\AppData\Roaming\Microsoft\Excel\XLSTART

b) To find, go to your C: drive under “This PC”, and search for “XLSTART”, it may take a few minutes 
to appear.

c) Enter and Paste the file inside this folder

1. Open Microsoft Excel

2. Go to File > Options > Trust Center > Trust 
Center Settings > Macro Settings

3. Click “Disable VBA macros with notification”, 
and “Enable Excel 4.0 macros when VBA 
macros are enabled”

4. If necessary, click “Trust access to the VBA 
project object model”

Enable the Macro
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Macro Applications

1. If you do not have the Developer Tab 
visible on your Excel ribbon, please 
enable it.

a) Excel > File > Options > Customize 
Ribbon and check/enable 
Developer

Display Developer Tab
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Create the Macro

1. Enter Forecast Commits screen (Here you can apply advanced 
filters or filter by exceptions if desired) 

2. To export all or the filtered selection, click on the                

            button, top right of the screen. 

3. A popup allowing you to select measures and timeframe will 
appear.

4. For creation of the Macro File, we recommend selecting all 
items and selecting your time frame.

c) Click export

5. To retrieve your export, go to the Documents Tab.

6. The forecast export will populate here for retrieval, click 
download:

5. Open Excel and Click on Macros under the Developer Tab

6. Select Personal.XLSB!MakeForecastCommitWorkingFile and 
click run.

7. Select your newly downloaded export file.

8. This will create the Macro File that will be used to make the 
other two.
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Create a Forecast Commit Upload File

1. With your newly created Macro File open, return to the 
Developer Tab and click Macros.

2. This time, select 
PERSONAL.XLSB!MakeForecastCommitUploadFile and click 
Run.

3. The file will be reformatted and ready for Commit Quantity 
entry. 

4. This allows for quick Forecast Commit entries, coinciding with 
the dates of our forecasted requirements.

a) Use this file to upload Forecast Commits back into LCT.
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Create a max capacity Upload File

1. Return to the previously created Macro File again, view the 
Developer Tab and click Macros.

2. This time, select PERSONAL.XLSB!MakeMaxCapacityUploadFile 
and click Run.

3. The file will be reformatted and ready for max capacity entry. 

4. This allows for quick max capacity entries, coinciding with the 
dates of our forecasted requirements.

a)  Use this file to upload max capacity back into LCT.
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